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Troubleshooting Federal
Child Count Reports
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The Ohio Department of Education and Workforce funds the development of EMIS
training materials as part of the EMIS Alliance grant. There is an expectation that
ITCs will utilize these materials in training provided to your districts. That said, there
are restrictions on use of the EMIS Alliance materials as follows: Materials
developed as part of the EMIS Alliance program must be provided at no cost to your
training participants. If you utilize the EMIS Alliance training materials — in whole or
in part — you must not charge participants a fee to attend the class where the
materials are used. Likewise, you may not use the materials or any portion thereof
in any event where a fee is charged to attend. Exceptions must be approved in
writing by the Department in advance of scheduling/promoting any event which
may violate these restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for
exception to the restrictions noted above, should be directed to Melissa Hennon
[Melissa.Hennon@education.ohio.qov].
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Overview

* The Federal Child Count (FCC)
* Includes students with disabilities who are receiving special education
services according to their IEPs as of October 31

* |s used in determining the amount of Special Education Part-B IDEA
and Early Childhood Special Education funds allocated to the state

* |s collected from all LEAs except for ESCs and JVSDs through the

Education Management Information System (EMIS) and is submitted
to the US Department of Education (USDOE)

* This presentation will focus on troubleshooting the EMIS FCC

Reports, which are generated throughout the EMIS data
submission process

EMIS
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EMIS Data Collections and the FCC Snapshot

* Collections containing the FCC report
* Beginning of Year Student (S) Collection
* SOES Beginning of Year Student (S) Collection

* Collections are scheduled to close December 20, 2024
* FCC will close when the above collections close
* There is no appeal for the FCC

EMIS
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FCC Reports

* Level 2 Reports
* (FCCD-001) Federal Child Count Detail
* (FCCS-001) Federal Child Count Statement of Assurances

* FCC Reports are updated nightly
* Can contain data reported by other LEAs

* Review the most recent version of the reports throughout the
data collection process

* Submit updated EMIS data to make corrections to the reports

EMIS
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Level 2 Reports

Beginning_of Year Student Collection (FY25)
FY25-S-TRAD Init: Collection required for all Traditional Districts, JVSDs, ESCs, and State Supported Schools. Source file(s) for GI, FS, FD, FN, GD, ... &

y - D 20, 2024 (126 days till close)

y
Version: 1 From ODE: Level 2 Reports
Status: The cellection was submitted yesterday at 03:12:38 PM
Submission Status: Processing Completed (yesterday at 03:12:44 PM)
Submission Number; 2 (attempt 1)
Actions: Start Collection
Add New Scheduled Collection
Set Default Collection properties

Submit Errors: None (has other errors or warnings})

Prepare Outputs: Level 1 Validations
View submission 2 Data

=z
Select the Level 2 Reports link

SOES Beginning_of Year Student Collection (FY25)
FY25-S-SOES Init: Collection required for all Community Schools. Source file(s) for FC,PSWEE, FL, FN, FS, FX, GD, GE, GG, GI, GJ, and GQ student rec... *
Submissions: August 08, 2024 - December 20, 2024 (126 days till close)

Version: 1 rom ODE: Level 2 Reports
Status: The collection was submitted August 13, 2024 at 03:48:45 PM
Submission Status: Processing Completed (August 13, 2024 at 03:48:47 PM)
Submission Number: 2 (attempt 1) Submit Errors: 0 errors, 1 warning, 0 messages (and other errors

Actions: Start Collection Prepare Qutputs: Level 1 Validations
Add New Scheduled Collection View submission 2 Data
Set Default Collection properties

EMIS
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- FCC Reports

Data Feedback Reports and Files
Pre-Submission to ODE | Post-Submission and Processing by ODE
Level 1 Details 1 Highlights and Recent | Level 2 Detalls Eecerved Files Details

Level 2 Details

Choose the filter criteria then click the Show Reports link to generate the list of Level 2 reports matching these criteria. To see the option to Generate a single .zip fite for alf
reports (.csv), you must select a single Report Name, or select a single LEA and a single Collection Request or a single Category.

LEA; below v Collection Request: | FY25-5-TRAD Init ~
LEA IRN: Report Nam

Processed on or after:

Data Set: [ 41l v School Year:[&ll v
Last Activity Within: | Al v

Category: | Al v

[ show closed collections

All ~
d/yyyy)

( (mm/dd/yyyy)
With Data Only: [ Exciude reports with 0 rows

Report Name include:

FCC was added to the

Group By:

® Collection Request () LEA O Level 2 Report () Category () Dataset () None
File Format: C

- filter in this example
) HTML @ csv O €3V by Building 1RN ) €SV by Other Field {see Field Name in the table below)
B faults | Reset Date textboxes

Process Date
 Beginning of Year Student Collection (FY25) (202551TRD)

D (rccp-001) Federal

(Count: 2
Kent City Schools_044164 128 17 14 531 688 Student Reports s 08/15/24 17:16  08/15/24 23:31 2 Unknown
Child Count Detail
© (rces-001) Federal chid Kent City Schools_044164 0 ) 0 15 15 StudentReports s 08/15/24 17:16  08/15/24 23:31 2 Unknown
Export report information &
\ EMIS
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Formatting the FCC Detail Report

* Open the (FCCD-001) Federal Child Count Detail Report
* Wrap text header row

* Freeze top row

Expand all columns

Apply filters

Better yet, run your macro!

Alliance




10/21/2024

Quick Check * Are you using the most recent

_ _ version of the report?
The Federal Child Count Detail

"\ Report contains student detail * Are you able to open and format

| dataasitpertainstothe the CSV report to begin the review
count. This report is critical in
process?

. the data review and error
i correction process and should e Can you app|y filters to all

H be carefully reviewed for 5
f}f accuracy and completeness. columns?
\ ince
9
| Troubleshooting

\ the Federal Child Count
f Detail Report

10



10/21/2024

Troubleshooting the FCC Detail Report

The next series of slides will review data contained in the
report including
* Severity Codes and Numbers
I * Federal Child Count Flag
"i * Who is and is not included in my FCC?
* FCC Report Data
* Status Codes and corrective actions

EMIS
\ -
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Severity Codes
* Severity Codes
* Report is sorted from least severe to most severe
* Severity Code will be noted for each Status Code
* Review all students regardless of Severity Code
o ”n
| A B c ] © E F G H i J K
STATE
EQUIV
GRADE|FED CCT
SEVERITY LEVEL |STATUS
1 LEAIRN Bldg IRN|CODE \SSID Emis ID Last Name First Name Middle Name |[CODE |CODE FED CCT STATUS CODE DESCR
ol N I- Informational  faeeir| {iems e et o
4 | 404040 229901]I BA1SQ5 —_ 1 Middle N 1)FC0008 N identified in ODE ing
5 404040 229901]! JF599: W \A'Ia'rnlng M:ddl:N::: 1/FC0008 Ngz:g: :d::t:f::d ::ODEEEE::::g
C — Critical
EMIS
F - Fatal e
\ Aliiiiaﬁce
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Federal Child Count Flag

* FED CCT FLAG
* Y —Student is intended to be included in the Federal Child Count
* N — Student not included in the Federal Child Count
* Review all students on the report regardless of flag

i J K L M N o P Q R
FED CCT LEGAL DISAB
STATUS FED CCT |FED CCT LRE DISTOF CNDTN STDNTAGE DIST LRE SRC
1 | CODE FED CCT STATUS CODE DESCR FLAG CODE RESIRN CODE NUMBER CODE DIST LRE SRC DESCR
2 | FC0008 No errors identified in ODE processing |Y IE14 60606005 778 GE Record
3 | FC0008 No errors identified in ODE processing |Y IE13 60606005 778 GE Record
4 | FC0008 No errors identified in ODE processing |Y IE15 60606001 6’8 GE Record
5 | FC0008 No errors identified in ODE processing |Y IE39 60606005 6 A Sent Reason = AU or JP
EMIS
\ dlhes
13
Who is included in my FCC?
* In most cases, students count at their resident district except for
students attending -
* Community Schools
* STEM Districts
* Buckeye United (DYS)
| * Non-Public students receiving related services count at the traditional
district providing the related services if an active IEP event is reported as
of October 31
EMIS
\ -
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Who is not included in my FCC?

* Students with a disability as of October 31, who are not
being reported with an active IEP event as of October 31

* Students reported with the following IEP outcomes
* [EPR — IEP Complete — Parental Refusal
* [ENS — IEP Complete — Not Served
* |[EDP — IEP Resulted in Due Process

* Refer to the FCC Level 2 Report Explanation, section “Include
in USDOE Count” for additional information and exceptions

EMIS
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FCC Report Data
* Disability Condition Code

* Student must be reported to EMIS with a disability as of October
31 to be included on the report

* Review for accuracy

 Student Age Number
* Student’s age as of October 31

J K L M N o PP ] a R

FED CCT LEGAL |DISAB

STATUS FED CCT FED CCTLRE DISTOF |CNDTN STDNTAGE DIST LRE SRC

CODE  FED CCT STATUS CODE DESCR FLAG CODE RESIRN |[CODE NUMBER CODE DIST LRE SRC DESCR
FC0008 No errors identified in ODE processing Y IE14 606060 5 7 8 GE Record

FC0008 No errors identified in ODE processing Y IE13 606060 5 74 8 GE Record

FC0008 No errors identified in ODE processing Y IE13 606060 5 7 8 GE Record

FC0008 No errors identified in ODE processing Y IE13 606060 16 7 8 GE Record

EMIS
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FCC Report Data, cont’d

* Legal District of Residence
* FED CCT ALT IRN
* Populated for Status Code FC0006 with LEA IRN where the student will count

* Sent Reasons and IRNs
* Displays if relevant to the FCC

M N (e} P Q R S T u v w X i
LEGAL [DISAB SENT SENT
FEDCCT |DISTOF CNDTN STDNT AGE DIST LRE IFED CCT JADMSN JREASON 1 SENTTO1 REASON2 SENT TO 2§ LEVEL2 REC
LRECODE |RESIRN CODE NUMBER  SRCCODE DIST LRESRCDESCR  JALTIRN |DATE |CODE LEAIRN  CODE LEAIRN | TYPECODE
IE14 606060 5 7 8 GE Record 00:00.0J0E 23356 FCCD-001
IE13 606060 5 7 8 GE Record 00:00.0 FCCD-001
IE15 606060 1 6 8 GE Record 00:00.0 FCCD-001
1E39 606060 5 6 A SentReason = AU or JP 00:00.0)P 23356 FCCD-001
IE15 606060 1 6 8 GE Record 00:00.0, FCCD-001
606060 8 6 5 No IEP Reported 00:00.040E 23356 FCCD-001

EMIS
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FCC Report Data, cont’d

* FED CCT LRE Code — Least Restrictive Environment Code
* If this is blank, the student is not included in the count
* Value comes from IEP, FN270, or is derived

* DIST LRE SRC CODE and DIST LRE SRC DESCR

* Source codes indicate what data the report is looking at

* Use in combination with the Status Code value to determine what is being
reported for each student

L Mol N o P | o R s T U v
|EGAL  DISAB SENT
FEDCCT [FEDCCT  [DISTOF CNDTN STDNT AGE [DIST LRE FEDCCT ADMSN REASON 1 SENTTO 1
FLAG  |LRECODE RESIRN CODE NUMBER [SRCCODE DISTLRESRCDESCR |ALTIRN DATE CODE  LEAIRN
¥ IE14 606060 5 7 8 GE Record 00:00.0 OF 23356
Y IE13 506060 5 7 8 GE Record 00:00.0
¥ IE15 606060 1 6 8 GE Record 00:00.0
% 1E39 606060 5 53 Sent Reason = AU or JP 00:00.0 JP 23356
¥ IE15 606060 1 6 8 GE Record 00:00.0
N 506060 3 5 5 No IEP Reported 00:00.0 OF 23356 EMIS
T, Sl E
Alliance
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DIST LRE Source Codes

* 1 - No Disability on October 31
| *3-Student’sageisnot 3-21

*5-No IEP Reported

*7 - FN270 Override

* 8 - GE Record

L | M | ™ I Q P 1 (] | R | s | T | u | v
f LEGAL DISAB SENT
FED CCT FEDCCT DIST OF CNDTN STDNT AGE DIST LRE FEDCCT ADMSN REASON1 SENTTO1
FLAG  LRECODE RESIRN CODE MUMBER  [SRC CODE DIST LRE SRC DESCR  JALTIRM DATE CODE LEAIRN
8 1E14 606060 55 7 8 GE Record 00:00.0 OE 23356
& § IE13 606060 -] 7 8 GE Record 00:00.0
Y IE15 606060 1 (=3 8 GE Record 00:00.0
Y 1E39 606060 5 (53 N Sent Reason = AU or IP 00:00.0 IP 23356
Y IE15 606050 1 53 8 GE Record 00:00.0
N 606060 8 6 5 Mo lEP Reporied 00:00.0 OE 23356
\ EMIS
\ gy ;‘.‘ﬂféi‘;{'r‘v 19
Alliance
19
4
DIST LRE Source Codes, cont’d
* 9 - How Received =6
* FED CCT LRE CODE will be IE39 Ages 5 and up, Not Grade Level PS
\ .
| * FED CCT LRE CODE will be IE39 Ages 6 and up, Grade Level PS
! .
* C- How Received = 6 and Grade Level =PS
* FED CCT LRE CODE will be IE51 if Ages 3 to 5 and Grade Level PS
* A - Sent Reason = AU or JP
* FED CCT LRE CODE will be IE39 if age 6 or older and IE51 if age 3-5
* B - Changed to DYS LRE (Appears only on DYS report)
r L | L | ™~ | o | P | Q | R | S | T | u | v
LEGAL DISAB SENT
FED CCT FEDCCT DIST OF CNDTN STDNT AGE DIST LRE FEDCCT ADMSN REASOMN1 SENTTO1
FLAG | I:_R__E_CODE RESIRNCODE __NUMBER____SRC CODE DIST LRE S__RC DESCR | _ALT IRN DATE _ CODE _LEAIFEN______
Y 1E14 606060 5 7 8 GE Record 00:00.0 OE 23356
¥ 1E13 606060 5 7 & GE Record 00:00.0
Y IE15 606060 1 (5] 8 GE Record 00:00.0
Y 1E39 606060 5 (3 -% Sent Reason = AU or JP 00:00.0 JP 23356
Y 1E15 606060 1 6 8 GE Record 00:00.0 EMIS
N 606060 8 6 5 No lEP Beported 00:00.0 OE 23356 ey )
\ s T 20
Alliance
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Quick Check

The Federal Child Count Detail
Report contains data specific
to students with disabilities.
Understanding each column
of data is important to begin
analyzing the data for
accuracy and completeness.
There is not an error for
everything, so time spent
reviewing all data on the
report is recommended.

* Are all students appearing on the
report as expected?

* Has someone verified the data for
accuracy?

* Has updated EMIS data been
submitted to correct any
inaccuracies on the report?

EMIS
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FED CCT Status Codes
FED CCT STATUS CODE and FED CCT STATUS CODE DESCR

* Indicates the status of a student as it relates to inclusion in the count
* Indicates that a data issue exists or that no errors are identified
* Data with no errors on the report should still be reviewed for accuracy
| J K L M N o)

STATE

EQUIV

GRADE |FED CCT FED CCT LEGAL DISAB

LEVEL |STATUS FED CCT LRE DISTOF CNDTN

CODE |CODE FED CCT STATUS CODE DESCR FLAG CODE RESIRN CODE

PS FC0008 No errors identified in ODE processing Y IE51 6060860 5

PS FC0004 No IEP reported for Oct 31 date N 606060 16

PS FC0008 No errors identified in ODE processing \f IES1 606060 12

PS FC0008 No errors identified in ODE processing Y IE51 606060 5

PS FC0004 No IEP reported for Oct 31 date N 606060 12

EMIS
W 22
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FED CCT Status Code FCO001

Filter on FCO001

* On Oct 31 Student age is outside the 3-21 included range (Fatal)
* Source Code 3 - Student age is not 3—-21
* FED CCT FLAG-N

* View the student’s reported date of birth on the Student
Demographic (Gl) Record to confirm age

* If the student’s date of birth is incorrect, make the correction and
submit updated EMIS data

EMIS

Alliance
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FED CCT Status Code FC0002

Filter on FC0002

* Unable to translate LRE-must report FN270 element (Critical)
* Source Code 7 - FN270 Override

* or Source Code 8 - GE Record
* FED CCT Flag- N

* As of October 31, the student’s IEP Outcome (LRE) must agree
with the student’s age and grade level

* For ages 3-5 and in preschool, the LRE should be in the IE51 to IE72
range, if not report an LRE within this range on the FN270

* For ages 5 and over and in kindergarten or higher, LRE should be in
'Ic:I'Il\lezl7E013 to IE39 range, if not report an LRE within this range on the

EMIS
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Age, Grade Level, and Expected LRE

* Age 3to 5, Preschool Grade Level - Count as Preschool Student
* Preschool LRE Expected (IE51-1E72)

* Age 4, Kindergarten Grade Level - Count as Preschool Student
* Preschool LRE Expected (IE51-1E72)

* Age 5 and up, Kindergarten Grade Level - Count as School Aged
Student
* School Aged LRE Expected (IE13-1E39)

* Age 6 and up, Any Grade Level, including Preschool - Count as
School Aged Student
* School Aged LRE Expected (IE13-1E39)

EMIS
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Reporting the FN270 Element
Updated October 31 IEP Outcome Element (FN270)

* The current IEP outcome and FN270 values should not be the same

* When the FN270 value is reported correctly the LRE that aligns with
the student’s age and grade level will appear in the column FED CCT
LRE CODE

* When reported incorrectly the FED CCT LRE CODE column will be
blank

J K L M N (o] P Q R
FED CCT correct LEGAL DISAB
STATUS FED CCT FED CCTLRE DISTOF CNDTN STDNTAGE DISTLRE SRC
CODE FED CCT STATUS CODE DESCR FLAG CODE RESIRN CODE NUMBER CODE DIST LRE SRC DESCR
FCO008 No errors identified in ODE processing R IE13 60606016 78 GE Record
FC0008 No errors identified in ODE processing Y IE13 606060 06 78 GE Record
FC0002 Unable to translate LRE- must report FN270 element N 606060 05 68 GE Record
FC0002 Unable to translate LRE- must report FN270 element Pl 606060 16 68 GE Record
/ EMIS
Incorrect e

s
Alliance
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Additional Information on FN270 Reporting

* When completing the Federal Child Count, the Department will
review the LRE on the latest reported IEP event effective as of
October 31

* The value in the FN270 element will take precedence
* Reporting of an FN270 value is not limited to PS and KG

* For this element to be valid for the Federal Child Count, the
student must already have an IEP reported to the Department

that is valid on October 31. If no reported IEP is valid on October
31, then the value in this element will be ignored

27

Additional Information on FN270 Reporting, cont’d

In general, the LRE will not change without a new IEP being
completed and reported, but there are some cases, especially

with IEPs reported in the prior year that are still in effect on
October 31, where the LRE could change

* Examples include but are not limited to

* a student whose parent originally consented to services but pulled the student
from services prior to October 31

* situations where an expelled student is given an alternative placement that will
be in effect on October 31

* a preschool student (especially for those who are part time), a parental

placement in a private preschool program could change the LRE for that
student

* For questions on FN270 reporting, please contact your ITC

28
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FED CCT Status Code FCO003

Filter on FCO003

* CIEP most recent IEP - should be no disability (Warning)
\ * Source Code 8 - GE Record
‘ * FED CCT FLAG-N
* Verify the CIEP event and confirm that the student’s disability code
,Ag‘ is being reported as ending on the date of the CIEP event
4":‘;1‘ * If the student’s disability code on the Student Attributes - Effective
,('_ Date (FD) Record is not reported as ended, make the correction
f and submit updated EMIS data

EMIS

29

\ Alience
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FED CCT Status Code FCO004

Filter on FCO004

"\ * No IEP reported for Oct 31 date (Fatal)
* Source Code 5 - No IEP Reported

‘ * FED CCT Flag—N
* FED CCT LRE CODE — Blank

| * Verify the student’s special education event records as of October 31
_5‘;# * Verify the most recent IEP was reported to EMIS
({' * Report an NIEP if appropriate

EMIS

30
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ODDEX Records

| Special Education Data Tab

. . )
* Use to verify if the student’s IEP events were reported to EMIS
1 Departmentof
(Dim [“"::'6:" &  Ohio District Data Exchange (ODDEX) Records Single Student
SOES~ SCR~ SCM~ Records ~ CCP~ Tuition~ Grad~ n
& Retum to Summary Help
Name ssiD Birthdate
f Event Date Event Type Outcome Outcome Dates Non-Compliance Secondary Planning Required Test Type Reported by LEA
02/20/2024 RIEP IE14 N/A NIA STA
03/06/2023 RIEP IE14 N/A NIA STA
08/26/2022 AIEP IE14 N/A NIA STA
EMIS
‘ - i}ﬂjﬁii;'f‘ 31
\ Alliance

31

NIEP Date Type - No IEP

| * NIEP events for expired or non-transferable IEPs

* 10 - Student newly transferred in; IEP adoption determination not
complete; services being provided based on prior IEP

* 11 - IEP expired; new IEP not in place; services being provided
based on prior IEP

* NIEP events using the non-compliance reason of 12 can be
| used until the end of the IEP that did not get reported to
~ EMIS

Alliance

32
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FED CCT Status Code FCO005

Filter on FCO005

* Student does not meet inclusion filter in this district (Warning)
"1 * Source Code 5 - No IEP Reported

| * or Source Code 7 - FN270 Override
\‘ * or Source Code 8 - GE Record
* FED CCT Flag—N

* Shared students can have this Status Code at the educating district

* Shared students where IEPs are not reported can also have this
Status Code with Source Code 5 — No IEP Reported

* Refer to the Federal Child Count Report Explanation, section “Include
in USDOE Count”

EMIS

33

Alliance

FED CCT Status Code FCO0Q05, cont’d

Filter on FCO005

* Student does not meet inclusion filter in this district (Warning)
* Source Code 9 — How Received =6
* FED CCT Flag—N

* Non-Public special education students receiving related services
from reporting district with No IEP reported on October 31
* Report does not consider ISPs

* If no IEP in place on October 31, then the student is not included in
the FCC

EMIS

34
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Multiple District Tie Breakers

1. Will count at Buckeye United if reported by Buckeye United (060988)

| 2. Will count where Reporting IRN = District of Residence IRN
‘1 ~OR~ counts where Reporting IRN is reporting a How Received code of
\ M (Community School) or K (STEM District)

3. If multiple entities are claiming the student in the same way (as #2
above), then the student is included at the entity with the later
¥ | admission date

)} ' 4. If entities are claiming the student in the same way (as #2 above) and
/' reporting the student with the same admission date, then the student
| will not count for any district

EMIS

35
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FED CCT Status Code FCO006

Filter on FCO006
* Student counting in alternative district - does not count in your district
(Warning)

| * Source Code 5 — No |IEP Reported - verify if special education events need to be reported
1 for this student

\ or Source Code 7 - FN270 Override

or Source Code 8 - GE Record

or Source Code 9 - How Received = 6

or Source Code C - How Received = 6 and Grade Level = PS

or Source Code A - Sent Reason AU or JP

FED CCT Flag - N

* Student counts at the IRN in the FED CCT ALT IRN column

/ * Review data in ODDEX to compare how data is being reported

« Communicate with the alternative district to determine how this student should
be reported

EMIS

36

\ Alliance

36
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FED CCT Status Code FCO007

Filter on FCO007

* Student excluded -conflict in where the student should count (Fatal)
"1 * Source Code —7 FN270 Override
w * Or Source Code — 8 GE Record
| * FED CCT Flag - N

* Could not determine where this student should count, so the student
will not be counted at either entity

r / * Review data in ODDEX to compare how data is being reported by both
: entities

r/ * Communicate with the other entity to determine how this student
| should be reported

EMIS

"‘ NS 37
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FED CCT Status Code FCO008

Filter on FCO008

* No errors identified in DEW processing (Informational)

Source Code 7 — FN270 Override

or Source Code 8 — GE Record

or Source Code 9 — How Received = 6

or Source Code A — Sent Reason = AU or JP

or Source Code B — Changed to DYS LRE (appears on Buckeye United FCC Report)
or Source Code C — How Received = 6 and Grade = PS

* FED CCT Flag - Y

* Data for the students should be reviewed for accuracy
ai * Apply filters to verify elements such as disability conditions and LREs

/ ‘ * District staff can be very helpful in verifying data accuracy and
r completeness

EMIS

38
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Quick Check

The Federal Child Count Detail
report will display students
who are and who are not
included in your count. The
report will also indicate
students with issues
preventing them from being
included. Check this report
often as it can be affected by
another entity’s EMIS
reporting.

* Have all status codes been
reviewed, and all reporting issues
corrected?

* When corrections have been
made in the student information
system (SIS), has that updated
data been submitted to EMIS?

* Based on inclusion criteria, are all
of your special education students
being counted correctly?

EMIS

N 39
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Troubleshooting
the Federal Child Count Statement of
Assurances Report

EMIS

40
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Open the FCC Statement of Assurances Report

A B €
1 DISAB CNDTN CODE DISABILITY DESCR STUDENT COUNTS Format the report
‘ 2 |- 3,4, and 5 Year Olds With a disability (Any) 25 by wrapping the
| 3 1 Multiple Disabilities (other than Deaf-Blind) 7 .
\ 4 2 Deaf-Blindness 0 textin the header
\ 5 3 Deafness (Hearing Impairment) 5 row and expanding
‘ 6 4 Visual Impairments 6 a" columns
% 5 Speech and Language Impairments 13
| 8 6 Orthopedic Impairments 1]
i‘! 9 8 Emotional Disturbance (SBH) 12
,-‘1 10 9 Intellectual Disabilities (Formerly Mental Retardation or -see Manua 10|
‘f‘:‘f 11 10 Specific Learning Disabilities 12|
_5 | 12 12 Autism 2
{(_ 13 13 Traumatic Brain Injury (TBI) 0
| 14 14 Other Health Impaired (Major) 3
| 15 15 Other Health Impaired (Minor) 6|
‘ 16 16 Developmental Delay 4
EMIS
\ S 41
\ Alliance

41

Understanding Statement of Assurances

* The report includes
w * only students who have a FED CCT Flag=Y
\ * all students age 3 to 5 in the first category
\ * students age 6 to 21 in each disability specific category

* Using the above criteria, the next series of slides will match
| the FCC Detail Report against the FCC Statement of
Assurances Report

ﬁ‘;:’l * When you are told that the counts on this report are
| incorrect, filtering allows you to show which students are
! included or not included

EMIS
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Filter on FCC CCT Flag
D E F G | H | | J | K L
STATE
EQuIV
GRADE  FEDCCT
\ LEVEL  STATUS FEDCCT
\l, SSID ~|Emis|D |~ |LastName |~ |FirstName |~ |Middle Name | |CODE |~ |CODE FED CCT STATUS CODE DESCR / FLAG  |T|
'k; AJ9337130  B18000002 08 No errars identified in ODE processin, 2] sortAtoz
AX6753160  B18000003 08 No errars identified in Q) essing
enssssss esooons | Select Y on the 08 7 ODE pragessing | A0 2174
JF5996371  B18000005 . 08 d in ODE processing Sort by Color s
wasssir etsoonoes | FED CCT Flag Filter on d in ODE processing
MD5131530  B18000008 . 08 d in ODE processing
wusstrsis ssoooors | the FCC Detail Report s din ODE progessing | 1 Cler Fier From 'FED CCTFLAG™
XF5317335  B18000010 08 tified in ODE processing
¥09950199 B18000011 LastName  FirstName  Middle Name 1 FC0008 { Text Filters >
YX3697033 B18000012 LastName  FirstName  Middle Name 1 FC0008
YX5353763  B18000013) 08 Search
msaserss sl These are the students | | select Al)
DI9305335  B18000015) 08 No errors identified in ODE processing LN
wasnezr ssoooss| who are included in 08 Noerrors identified in ODE processing oy
f LX7593339  B18000017) 08 No errors identified in ODE processing
SM5369935  B15000018 the Statement of 08 No errors identified in ODE processing
XU7966981 B18000019) 08 No errors identified in ODE processing
HK5760563  B18000022] Assu rances Report 08 No errors identified in ODE processing
MI5677335  B18000024) No errors identified in ODE processing
\ OE1953905 B18000025 LastMame  FirstName  Middle Name 3 FC0008 No errors identified in ODE processing e
\ Z15915970 B18000027 LastName  FirstName  Middle Name 3 FC0008 No errors identified in ODE processing
\ EMIS
R 43
\ Alliance
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Add Second Filter on Student Age Number

G H | I 1 K L M N (o] P
STATE
\ EQUIV
\l GRADE  FEDCCT LEGAL DIST DISAB
| LEVEL  STATUS Select ages 3, 4 and FEDCCT  FEDCCTLRE OFRES  CNDTN  STDNTAGE
FirstName | |Middle Name | v |CODE |~ |CODE ~|FLAG  |.T|CODE > IRN ~|CODE |~ /NUMBER |~
FirstName  Middle Name s | 5 on the Student Age Y IEL4 | 51 SortSmallestto Largest
FirstName  Middle Name 1 FCO008 . Y IE13 Z| Sort Largest to Smallest
Al sortlarg
FirstName  Middle Name 1 FCD008 Number Filter i IE15 Sort by ol ,
FirstName  Middle Name 1 FCOO08 T o i IE38 -
FirstName  Middle Name 1 FCO008 No errors identified in ODE processing Y IE15
FirstName  Middle Name 1 FC0008 No errors identified in ODE processing Y IE15 SZ Clear Filter From "STDNT AGE NUMBER"
FirstName  Middle Name 1 FCO008 No errors identified in ODE processing Y IE13
FirstName  Middle Name 1 FC0008 No errors identified in ODE processing Y IE13 HunEerEiters: ;
FirstName  Mi - — - Y IE13 —
pevene Ml These students are included in the 3 ! .
FirstName ~ Mi ’ | 8 (Select Al 2
. . ope “3
| |feere it 4, and 5-year-olds with any disabilit r e o
| |Fisthame M ? Yy y A\ ¥ IE15 @5
= h 06
Fanane M| on the Statement of Assurances report| ! & £
FirstName  Mi Y IE39 Os
FirstName  Middle Name 2 FC0008 No errors identified in ODE processing Y IE13 i)
FirstName  Middle Name 2 FC0008 No errors identified in ODE processing Y IE13 o N
‘.‘ FirstName  Middle Name 3 FC0008 No errors identified in ODE processing Y IE15 ==
\ ancel
FirstName  Middle Name 3 FC0008 No errors identified in ODE processing X IE13 .
EMIS
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Matching Data Between Reports

2. This will match the count on the Statement of

Assurances.
| L M N o P Q R 5 A 8 o~ €
\ - 3,4, and 5 Year Olds With a disability (Any o~
i
il 1 Multiple Disabilities (other than Deaf-Blind) 7
1. From the filtered students on the FCC Detail Report, 2 Deat-Blindness 0
select a range of cells and see the “count” appear at 3 Deafness (Hearing Impairment) 5
the bottom of the spreadsheet. 4 Visual mpairments ‘ 6
" T S0 = : T 5 Speech arjd Language Impairments 13
v 15 506060 5 8 GE Record 6 Orthopedic Impairments 1
v [E13 506060 5 7 FN270 Override 8 Emotional Disturbance (SBH) 12
! L2 S0ucl 2 1IMZ/0Overyide 9 Intellectual Disabilities (Formerly Mental Retardation or -see Manua 10
v F12 506060 5 7 FN270 Override T %
[ IE14 506060 5 7 FN270 Overide pecihc -eaming Disaoiies
| ¥ [E13 506060 5 7 FN270 Override 12 Autism 2
1 v 13 506060 5 7 FN270 Ouerride 13 Traumatic Brain Injury TBI) 0
i 2 2o < iR 14 Other Health Impaired (Major) 3
v E14 506060 5 7 FN270 Override
; —_— —_— = = 15 Other Health Impaired (Minor) 6
(FCCD-001) Federal Child Count ® i [ ] 0
FiterMoce 53 Accessbilry Uravallable mwym‘mgs B E N -—a— 16 DevetopmemalDelay 4
,\ <
EMIS

™" 45

Alliance
45
File Home  Insert  Pagelayout  Formuas Data  Revi@@  View utomate  Developer  Help  Acrobat
@ E]‘_] Iﬁ EI S & Headings
| . Notmal|Page Break Page Custom | Navigation
|| preview Layout Views [] Formula Bar
\ Shestview Workbook Views snow
\" Autosave @ o) o TS =
B26 e fe e
With two spreadsheets
A B C D
|DISAB CNDTN DISABILITY DESCR STUDENT COUNTS open at the same time,
= 3,4, and 5 Year Olds With a disability (Any) 25 .
1 Multiple Disabilities (other than Deaf-Blind) from the View tab select
2 Deaf-Blindness

4 Visual Impairments

1
2

3

4

5 3 Deafness (Hearing Impairment)

6

7 5 Speech and Language Impairments
8

6 Orthopedic Impairments

9 8 Emotional Disturbance (SBH)
f 10 9 Intellectual Disabilities (Formerly Mental Retardation or -see Manua

11 10 Specific Learning Disabilities
12 12 Autism
13 13 Traumatic Brain Injury (TBI)
14 14 Other Health Impaired (Major)

‘-\ 15 15 Other Health Impaired (Minor)
16 16 Developmental Delay

7
s “Arrange All” and then
T = “Vertical” and “OK”

Arrange Wind...

Arrange
) Tied
_J Hgrizontal
8) \Vertical

) Cascade

[_] windows of active workbaok

EMIS
Vo™ 46
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Arrange All cont’d

“Arrange All” allows
both spreadsheets to
be viewable at the

same time
A B C < A B € b) 3 f & H
1 |DISAB CNDTN DISABILITY DESCR STUDENT COUNTS
2 |- 3,4, and 5 Year Olds With a disability (Any) 25
3| 1 Multiple Disabilities (other than Deaf-Blind) 7
SEVERITY
4 2 Deaf-Blindness 01 | 1 |LEARN BdgIRN F/CODE 158D [+|EmisD (7] LastNeme [<[FirstName [-|MiddleName =
5| 3 Deafness (Hearing Impaimment] 51 2| a0aa0 2209011 9337130 B18000002 LastName  FirstNeme  Middle Name
6| 4 Visual Impairments B1[3] 404040 2299011 AX6753160 B18000003LastName  FirstName  Middle Name
7 5 Speech and Language Impairments 13 4| 404040 229901 | BA1555355 B18000004 LastName  FirstName  Middle Name
8 6 Orthopedic Impairments 1) |5 404040 229901 | JF5996371 B18000005 LastNeme  FirstName  Middle Name
9| 8 Emotional Disturbance (SBH) 126 404040 2299011 LY1955107 B18000006 LastName  FirstNeme  Middle Name
10 9 Intellectual Disabilities (Formerly Mental Retardation or -see Manua 10 7 404040 229901 F MA3353050 B18000007 LastName  FirstName  Middle Name
Hl A0IShecific \Lasrhing Disabiltias 12 |8 4o4a0 2208011 MD5131530 B18000008 LastName  FirstNeme  Middle Name
p: 4

5 5 iom 5 | 9] aomd0 2205011 WU9917913 B1800009 LastName  FirstName  Middle Name

0| 404040 229901 | XF5317335 B18000010LastNeme  FirstName  Middle Name
i) 13 Traumatic Brain Injury (TEI) 00l aoapa0 2299011 Y09950199 B1800011LastName  FirstName  Middle Name
4 14 Other Health Impaired (Major) 30 [12] 404040 2299011 YX3697033 B18000012LastName  FirstName  Middle Name
15 15 Other Health Impaired (Minor) 613 404040 229901 YX5353763 B18000013LastName  FirstName  MiddleName
16 16 Developmental Delay 4| (1] 02040 2299011 BJ5396753 B18000014 LastName  FirstNeme  Middle Name

EMIS
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Change the Student Age Filter

& LS L L 1 N il o ! F
|FED CCT LEGAL DIST DISAB
?STATUS FED.CCT FED CCT LRE OF RES CNDTN  STDNT AGE
1 |CODE ~ | FED CCT STATUS CODE DESCR | IFLAG |-¥|CODE > |[IRN ~|CODE |~ |NUMBER
14 |FC0008 No errors identified in ODE processing Y IE39 2] SortSmallestto Largest
{ No errors identified in ODE processing Y IE15 =
16 |FCO008 No errors identified in ODE processing ¥ IE13 £l sortLargest to Smallest
i e ¥ 1E33 Sort by Calor »
¥ IE13
!{ Leave the FED CCT Flag [* ! e
2, Y IE15
= Column filter set to s 7 \E13 | T2 Clear Filter From "STDNT AGE NUMBER"
2 g ¥ IE15
| show only Y values & v IE1a
4 - e v IE13 Number Eilters »
LECO00R Mo ecroreidentified in ONE nroceacin v P
eard
3 . ¥
{ Change the filter for the Student v = Seect Al -
3 . IE15 13
:{ Age Number column to include \'v\&s.*
2 ¥ IE15
‘| all ages except 3,4, and 5 ! i
44 [FC0008 No errors identified in ODE processing A4 IE13
45 |FC0008 No errors identified in ODE processing ¥ IE15
48 |FC0008 No errors identified in ODE processing F IE13 — b
51 jFCBDOE No errors identified in ODE processing Y IE13 T 1
52 |FC0008 No errors identified in ODE processing L IEL5 (el

Alliance

48

24



10/21/2024

Add a Third Filt
E M N o
FED CCT LEGAL DIST DISAB
\ STATUS FED CCT FED CCT LRE OF RES CNDTN
\ 1_|CODE ~ | FED CCT STATUS CODE DESCR | = |FLAG ~-¥|CODE = IRN ~|CODE [
‘1' 4 |FC0008 No errors identified in ODE processing Y £ . SortSmallest to Largest
| & |FCooo8 MNo errors |der‘|(lf|ed in ODE processmg Y =
12 |FC0008 No errors id Lo Onc ¥ £l sorttargesttg =
15 |FCO008 No errors idg ¥ —Col »
s7ircoo0s  Noemorsiad Add @ third filter in v il A
60 | FCOO08 No errors idd] /
[{01|FCO008 N d Y
| gemors 1o the DISAB CNDTN “Z Clear Filter From "DISAB CNDTN CODE"
nao|
ket CODE column
hos| MNurnber Filters »
o4
= Search
hael . ore [ (Select All) -
ha7 Select one disability L, be
| il
| nos| . / o3
[ ool code at a time o
pOO| i
;01' 18
po1| 18
poz L9
pO3| 710 “
pOa4| i)
pos = - :
Bos| (LOR| | Eancel|
EMIS
T, ST
\ Alliance
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Match the Data Between the Reports

A B € L M N 0 P | @ R
- 3,4, and 5 Year Olds With a disability (Any) 25 LEGALDIST DISAB
w (L1 Multple Disahltis other than Deaf-Blind) 70| FEDCCT  FEDCCTIRE OFRES  CNDTN  STONTAGE  DISTLRESRC
I\ 3 Deaf-Blindness oIUFA6  TCODE  [+/IAN  |+/CODE LTNUMBER |-TICODE [</DIST RESRGDESCR -
l 3 Desines Hearngnpaimen 5 5 e 1 § B GE Recard
el AN o8 1 6 8 GERecard
A \isual Impaiments 6 1 \(Jis WK1 ; B 6F Recrd
5 Speech and Language Impairments 13| || 15 606060 1 7 8 GE Record
6 Orthopedic Impairments ! L 05D 1 11 £ GF Beroy
8 Emotional Distubance (SBH) 11 1. From the filtered students on the
2. This will match the count anua 11 FCC Detail Report, select a range
on the Statement of 1 of cells and see the “count” appear
| | Assurances. at the bottom of the spreadsheet.
14 Other Health Impaired (Major) 31 : _
15 Other Health Impaired (Minor) 6 | (FCCD-001) Federal Child Count. |\ (& ]
16 DevelopmentalDelay 4 ady 7 of 188 records found F@ ﬂ’qAccemhmt\;;Unawal\ah@&m\ayiemngi ﬁ
EMIS
‘ ~'-'.,;§;5‘?" .
\ Alliance
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Quick Check * Can you match the data between

The Federal Child Count the two reports using filters?

Statement of Assurances . . h f
Report is derived from the Are you seeing the numbers o

same data that is on the FCC students that you were expecting?

Detail Report. Using filters, . .
you can match the data * Has this data been shared with
between the reports. The others in your district?
Statement of Assurances is

sometimes requested by

auditors.

EMIS

Alliance
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Summary

* The FCC Reports contain both data to verify and issues to
correct

* Some issues can be corrected, and some are simply stating
the fact that the student cannot be included in the count

* Work with district staff to verify that the data is both correct
and complete

* “No errors” does not necessarily mean that your data is
accurate

EMIS

Alliance
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Resources

* Federal Child Count Detail Report and Federal Child Count
Statement of Assurances Report Explanation

e DEW Home > Data > EMIS > Documentation > EMIS Validation and
Report Explanations

* EMIS Manual
* DEW Home > Data > EMIS > Documentation > EMIS Manual

* Your district staff
* Your ITC

EMIS

>
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Questions?

If you would like a certificate of attendance for this
training, you must complete the below feedback form
within 5 business days of this training
https://tinyurl.com/EA-District-Feedback

EMIS

\ e
\ Alliance
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